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1.0 Introduction

Maximizer CRM is the Simply Successful CRM solution. CRM solutions include equal parts of advanced Sales,
and functionality. Maximizer CRM 10 provides new and existing users with
compelling new features and improvements in robustness, quality and usability. The theme of Maximizer CRM 10 is
“work the way you want to”. Primary areas of devel d X Office
native dows Mobile PDA appls

Maximizer Enterprise 9, v9.5, the previous version, already has

*  Extensive Sales functionality, with 21 years of development

. hmﬂml“arﬁeﬁuﬁmmnndltymh!yunddﬂem

. C Service Jity with more than 5 years of development

In addition to an updated interface and fresh logo, the product line is being re-positioned as Maximizer CRM. This will
m&u&:(&rmmawoﬂu’mphlnnubnmmb\m(suu)mdmpmeﬂcmvelynthr
changing

Maximizer CRM 10 will be divided into four editions that represent the target markets

This document lists the new features for the Group, Professional, and Enterprise Editions. The following matrix
outlines the key differences between the Group, Professional, and Enterprise Editions.

Maximizer Enterprise Maxmizer Enterprise
Y From w/G Maximuzer ise C/S CRM
Database MS SQL Express MS SQL Server MS SQL Server
User Limit 15 Unlimited Unlimsted
Web Access Available Available Available
Module
Functionality
'Advanced with Territory
Sales Standard Standard
o with Fax/Print
Marketing Standard Standard
o with
| Customer Service Standard Standard KnowledgeBase
*Advanced with Web *Advanced with Web
Business Intelligence Standard
. with Windows | *Advanced with
& Single &
| Security Standard

* Modules listed above will also contain additional Workflow events as part of their advanced functionality in their
respective editions
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Maximizer CRM Group Edition is the new oquivalent of the former Maximizer Enterprise’™ Pervasive Workgroup
product. The primary difference between the former product and the new Maximizer CRM Group Edition is that the
Group Edition now supports the Microsoft SQL Express database, and no longer supports the Pervasive Workgroup
database

Maximizer CRM Professional Edition is the new equivalent of the former Maximizer Enterprise Pervasive Client
Server product, and the former Maximizer Eaterprise M8 SQL CRM product. The primary difference between the
Pervasive Client Server product and the new Maximizer CRM Professional Edition is that the Professional Edition will
now only support the Microsoft SQL Server database

Maximizer CRM Enterprise Edition is the new equivalent of the former Maximizer Enterprise «CRM product

All 3 editions of Maximizer CRM 10 are available in either or hmh Windows and Web Access, and additionally u\dud'
the Partner, Customer, and Wireless Web Access. Also new to M CRM 10 are imp in the

products which will include support for Black Berry devices, and wireless synchronrzatson suppert for both Windews
Mobile and BlackBerry devices. The other major new product we are introducing in Maximizer CRM 10 is the new
Accounting Link for Micrasoft Dynamics GP
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38002 - Support Hum-conhﬁ fields in Hotlist, C: (PPC)

Support mul in Activities, Hotlist, and Calendar screens. Retrieve multi-contact appointments
in the Activities tab hx Aédnu Book, Opportunities and Cases. The Daily View is to display the Address Book entries
comma separated up to 35 characters (with ellipses to indicate more). The current build shows all appointments as
personal, this includes appointments with a single entry as well as appointments with multiple entries. When Schedule
a Meeting is selected, retneve all selected Address Book entries as attendees.

36592 - Multi-Contact i = GUI for h

Support the display and synchronization of the new Multi-contact Appointment dialog ficlds in MaxMobile for Mobile
Powered Smartphone devices. This feature is related to 38003 - Support Multi-Contact Appointment fields in
Activities and Calendar (Smartphone)

34281 - Support C y in the panel — GUI for Smartphones

Support category in the Documents panel, in Address Book, Opportunity and Customer Service windows.
This feature is for implementing the GUI elements.

34280 - Support Category in the Documents tab - GUI for PPC

Support document category for MaxMobile for Mobile Powered Pocket PC devices. In Documents tab for
Address Book Entry, Opportunity, and Customer Service add a new column named Category.

38272 - Create I1S Sy Server for

‘The 11S Synchronization Server component has been removed from the MaxMobile installation And a

separate
installation has been created. Maximizer CRM and Internet Information Services (115) Manager must be available in
order for the install to proceed

35095 - Prod: Services and C ies —
The Appmmmem du]ug has been updated to include the Products/Services and Categories fields. These ficlds are
d in new with the values for the related opportunity or case. These values can be
modified if necessary.
36591 - Cradle Sy to Support New Dialog Fields
Cradle Synchronization supports the new Ay dialog fields, Address Book entries,
Products/Services and Categories, and Activities
39264 - Change Product Name from CRM to

Change the product name on labels and graphics for MuMobnle for PPC and MuNob-le Smnnphom This feature is
related to feature 39265 - Change Product Name from CRM to y).
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2.0 Mobility
2.1 MaxMobile for Windows Mobility

33883 - Y for B v
Support for wireless synchronization of Address Book, and Customer Service entries including their
notes, documents and selected User-Defined Fields (UDF) has been added. First must be performed
via cradle then wireless synchronization may be performed directly from the mobile device. Wireless synchronization
is performed via Internet [nformation Services (115) hosting the Wireless Access and the MaxMobile device

35007 - Wireless Synch for (GUI for PPC)
A new icon has been added to ‘MaxMobile - Home” !hcm‘\ﬂmhu
settings and allows the user to perform a wircless sy 1o the provided Sy

synchronization options are available ‘Synchronize MaxMobile’ and ‘Reset Mu.Mnbdc

34235 - y for -~ Sy

Create an interface to support the sp of the folk g Wireless h Settings from Maximizer or
Administrator Synchronization URL and the abilty to add or remove mobile users from the Wireless Synchronuation
list.

38354 - Synch - Support Web Service Compression
To minimize bandwidth during Wireless Synchronization, data packets are compressed during wireless
synchronization

37573 - Support "Select User” for only

Support a scenario where there are fewer Maximizer desktop users than MaxMobile users by providing an interface for
users with Ad ator role rights to set up a MaxMobile device for another user. When MaxMobile

Synchronization is inttiated and the current user has Administrator role ndlu\ d\lplly the Sdetl MuMnbuk User

dialog box. This configures the MaxMobile device for the selected fi d using the

MaxMobile Settings defined under Preferences

opzm(he sync
URL. Two

Note the initial Address Book Synchronization between the Mobile device that has MaxMobale installed and the
MmmAMnnlaohmmbew‘tmndmlelm The MaxMobile users can perform wireless

y with the configured Address Book thereafter

34358 - MaxMobile - Install New .NET Framework Compact 2.0 SP1

Change the version of the NET Framework Compact from 2.0 t0 2.0 SP1.

35258 - Add Multi-user To MaxMobile

Support Product License Number (PLN) for bk ucts. A bile PLN is installed from the
Administrator module using Utilities > Install Multi-user License dialog. In the User dialog add the "MaxMobile’
module login entry. This entry is used to enable or disabled a user for MaxMobile synchronuzation

36263 - Cradle Synch - Check ‘MaxMobile’ Module Login Value

Check the user’s ‘MaxMobile’ module login setting when performing cradle synch. If MaxMobile' value is ‘disabled
'.hr-whmuﬂlnmw:rdblymhd"hy(behﬂomn‘w “MaxMobile is disabled, please see your database
for

35085 - Muiti-Contact Appointment - GUI for PPC

Support the display and of the new multi fields m MaxMobile for Mobile
Powered Pocket PC devices. Layout changes were made to introduce the new Address Book Entries tab, the new
Products/Services and Categories fields, multi-line edit control for activities field. Furthermore, label changes were
made for Appointments with Opportunity or Customer Service Cases, activity field was renamed to Subject and some
minor changes were made to the Details tab in order to accommodate the display of multiple Address Book entries
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2.2 MaxMobile for BlackBerry

34884 - Create for Y
The new MaxMobile for Black Berry product is a native application for BlackBerry 7000 and 8000 series devices. This
feature is related to features. 34886 — Implement Address Book Window; 34889 ~ Implement Hotlist Window
34886 - Add Book wind:
‘This feature creates an interface to list Address Book entries, including the values for basic fields, UDFs, and
add/modify/delete contacts in a company, activities, notes and documents. Feature includes

Edit Menu - Add/Modify/Delete Address Book entries

Search Menu - Search functions

Action Menu - Make a Call, Schedule a Meeting, Schedule a To-do
‘Windows Menu - Links to other modules

This feature is also related to 34887 — Add, Delete Address Book entries, 34888 - View, Modify Address Book entries.
B e i P A e o

BlackBery BlackBerry

e s o o o

teficija

34889 - Implement Hotlist Window
Support Maximizer Hotlist window on BlackBerry. This feature is related to feature: 34890 - Add/Modify/ Delete
Hotlist Tasks.

34891 - Implement Calendar Window
Support Maximizer Calendar window on Blackberry device. Calendar supports daily, weekly and monthly views in
addition to go to specific date.

35086 - Implement Appointment Dialog

Support the Appointment dialog. Umunhdd/dit/demewnmnwuw Add appointments in
MdmlonlOpmuMn-.orMmm-uﬂow modify, delete, or complete appointments in
Activities panel inside an Address Book, Customer Service Case, or Opportunity dialog. Furthermore, users may edit,
delete, complete appointments in Hotlist window This feature includes 35096 - Support Products/Services and
Categories - Database changes.
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34896 - Support Alarm for Appointments and Hotlist Tasks

Support alarm for Appointments and Hotlist Ta
36556 - Support Activities in Address Book Entry, Opportunity, and Customer Service Case
Dialogs
Implement the Activit anel in the Address Book Entry, Opportunity and Customer Servies Case dialogs. The
Activities panel displays Hotlist Tasks and Appointments Activities may be completed and view options are available
to Show carry forward unfinished activities, Show completed activities, and Show Appointments [n addition, options
are available to filter activities by date, All dates, Today, Tomorrow, Yesterday, This Week, Next Week, and Custom
34892 - Oppor d
Peature includes

& Interface 10 display Opportunities

& Creating the menu structure

& Implementing all the search functions

& Supporting sorting, filtering and view in Address Book

& Supporting phone call, send email and write a note actions
In addition this feature includes features: 34894 - Add, modify, and delete Opportunities and includes: Assign &

contact 1o the opportunity, Edit UDFs; Edit status, 34893 - Support Adding and Deleting Opportunities.

T o L=
e b e e “l-—r--—‘—l-

BlacxBeorry

|
|
]
J

34897 - Support Customer Service

Support view, add, modify, and delete Customer Service Cases; 34898 - Add/Delete Customer Service Cases;
34899 - View/Modify Customer Service Cases.
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36078 - Support Multi-contact Appointments
Support viewing multi-contact appointments in Wireless Access.

39576 - Check Module Login at Wireless Access Login
Only Maximizer users who's Web Access or Mobile module login setting is enabled may login to the Wireless Access.
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36310 - Support USB and Synchr ( d -~ 36314)

Support USB and Wireless synchronizing of Maximizer data. This feature is related to features: 36310 - USB Sync
Sync Address Book entries, 35246 - Sync Data as Per Preference Settings, 35245 - Sct Sync Preferences; 36312 - USB
Sync - Sync Customer Service Cases, 36326 - Wireless Sync - Sync UDFs; 36324 - Wireless Sync - Sync Hotlist Tasks;®
36327 - Wireless Sync - Sync Customer Service Cases, 36322 - Wircless Sync - Sync Opportunities; 36321 - Wireless
Sync - Syne Address Book entries; 36313 - USB Sync - Sync Hotlist Tasks, 36311 - USB Sync - Sync Opportunities
36314 - USB Sync - Syne Appointments, 36315 - USB Sync - Syne UDFs; 36316 - USB Sync - Sync Notes; 36325
Wireless Syne - Sync Appointments, 36836 - Wireless Sync Handle Dropped Connection

39626 - Support View Only During Scheduled Wi

During a scheduled wireless synchronization the Mobile user may uprn an Address Book entry, a Customer Service
case or an Opportunity for viewing, but when an attempt is made 10 edit the entry display a message box. The message
informs the user that a scheduled wireless synchronization is currently in progress and provides an option to cancel
the synchronization in order 1o edit the entry or wait for the synchronization to complete.

In Hotlist and Calendar window when the user tries to open a Hotlist task or an Appointment the message box will be
displayed. The message box will also be displayed if the user tries to open the Wireless Sync window.

39297 - Support Web Service Compression

Support compressing wireless synch data from MaxMobile for BlackBerry

37867 - Support Carrier Specific for
Allow the user 10 specify carrier specific parameters for the ’nl‘hmmnlm URL of wireless sync
36837 - Sched Sync for based Set on Device

lement scheduled sync options for wireless synchronization User can set scheduled sync frequency for Peak and
-peak times. Scheduled Syne options are available from the Options menu under the Full menu
39265 - Change Product Name from CRM to (BlackBerry)

Update the following areas with the New MaxMobile name- Icon in Programs window, the MaxMobile title bar in
BisckBerry. and the MaxMobile About page n BlackBerry

2.3 Wireless Access

34553 - Weekly Calendar View

Weekly calendar view has been added to the Wireless Access. In addition, an action mena has been added to support
switching from daily and weekly views.

34551 - Allow the customization of the Search Results Screen

Allow the customzation of the search resuits screen. Displayed fields will be determined by the selected Column Setup
listed in the Web. Config file Fields that may be shown include all Address Book Basic fields, and User-Defined Fields.
34552 - Add the Contact’s Email Add and to Screen
Contact’s email address and telephone number have been added to the Appointment screen of the Wireless Access. If
the device supports telephony, telephone numbers will be clickable Clicking the telephone initiates a phone call
Furthermore, if the device supports email, email addresses will be clickable When the user dlicks on the email address
the compose email screen appears and the To field is set with the Contact's email address This behaviour may vary
depending on which browser is used

36024 - Products/Services and Categories — Appointment Screen

Support the Products/Services and Categories fields on the Appointment sereen for the Wireless Access.

36025 - Products/Services and Categories - Add Fields to Opportunity Screen

Support the Products/Services and Categories fields on the Opportunity screen of the Wireless Access
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3.0 Web

3.1 Maximizer Web Access Administrator

33159 - Setup Users
Support for managing users has been added to Web Access Ad: A can add, modify,
and delete users.

In addition, support has been added to
& Set a user’s Logging, Format, Calendar/Hotlist, Transfer, and Overview Page preferences
& Set the user’s attributes (e.g. First name, Last name, Display name, Position, etc.)
& Define a user’s Access
- A-.numlo(}mpﬂ'“

& Setauser's and options
33145 - Setup UDFs
Setup User-Defined Fields (UDFs) have been added to the Web Access d

mave user-defined fields and folders, create, modify, delete user-defined fields and folder, ddlnddclﬂrltﬂ-m
table user-defined fields for Address Book, Opportunity, Campaign, Customer Service, and Users UDFs
33143 - Database Management

The Database Management module has been added to the Web Access A Support has been
added to create, open, and delete an Address Book via Database Management
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34845 - Support Create New / Employ Existing Address Book

The Create New / Emplay Existing Address Book option has been added to the Log in to field on the Web Access login
screen

33150 - Locations and Resources

Locations and Resources support have been added to the Prefe section of the M Web Access
Administrator Users can add, modify, and delete values from the Locations and Resources.

33151 - Address Book Category

Address Book Category support has been added to the P section of the Web Access Ads
Admimstrators can add, modify. and delete Address Book Category values

33153 - Opportunities

Support for Opportunities preferences have been added 10 Web Access Ads A can
add, modify, and delete values for Stages and probability of clase, Confidence Rating, Complete reasons.
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33156 - Key Fields tab

Support for Key Fields preferences has been added to the d can

add, modify, AMMMHWWMM—MW Caw.mdcmm

33160 - Setup Security Groups and Teams

Supmamn&-ndly,mdddmmmwu\dhn-mm
p N o

Web Access has
bers for a Security Group and Team.

34715 - Support Show Disabled Users option

Web Access can control f disabled users appear in the user control for the Appointment
nhlq This is beneficial in environments where it is not necessary to display disabled users in Appointment user
control, mmu“mmuu%h“m@ﬁlﬁnnnhmmhw-c!
option is located on the System Defaalt tab under Preferences.
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33149 - System Fields

Systern Fields support has been added to the Preference section of the Maximizer Web Access Admunustrator Users
can add. modify. and delete values from the followings system fields Notes Category for Address Book. Campaign
Notes Category, Customer Service Notes Category, Opportunities Notes Category. Do not solicit by, Products; Services,
Categonies, MaxExchange Distribution.

:mn Support Categories Items as Sub-items to Products/Services Items

Web Access can set G stems as sub-items to Products/Services tems This
oum-uﬂnﬂ-—d-h*—-»h—ndh"dm Web Access
38547 - P to Set IMAP and SMTP servers
Support the Web Access the IMAP or SMTP servers setting by providing the “Email

setting
Server Setting” option under Preference When the IMAP or SMTP server settings are defined in conjunction with
feature 38546, the Maumuzer Web Access user is sutomatically logged into the cmail server when any of the
Maximuzer Web Access email features are used.

33154 - Preferences - Customer Service

Suppart 1o manage Customer Service options has been added 1o the Web Access Ad:

Adminstrators can add, modify, or delete values for case detals fields. Billing Type, Case or Article Subject, Orgin,
Quese, Reason, Status, and Type. 1a addition, Admunistrators can set case options and specify users for case
mongoring This feature i related to feature 33657 — Customer Service Monitaring.
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39218 - Support Search For User
A Search For option has been added 1o the User list page of the Web Access Ad: A

First Name, and Last Name. If the Search For field is blank and the user clicks the Search button, all users will be
retrieved. Alternatively, clicking the Retrieve All Users button also retrieves all users.

34719 - Support Users and Groups in Multi-Contact Appointment

Support adding user and group in multi-contact appomtments.

35056 - Enforce User/Group Setup Rights & GUI Improvements

Update the Maximuzer Web Access Admmistrator module to allow the Ad the same User/Group Setup
rights as the deskiop Admunistrator module.

33657 - Cu Ser
whmw—dmmh—u—-ﬂummw‘n—
MMmd&—M-‘u-ﬂm--ﬂuwﬂmﬂ
templates for the following case actions. Create, Assign. Escalate, and

3.2 Maximizer Web Access

32079 - Support Email Window in Maximizer Web Access
The Email window is completely server-based and supports SMTP and IMAP. The Email window is accessed by

dialog
panes, the left pane displays the available email folders and the nght pane displays the emads of the selected email

35921 - Email Windows Support - Compose Email dialog

The Maximizer Web Access Compose Email dialog supports plain text or HTML emaidls. Add & menu named
‘Compose New Email’ 10 the Edit menu of the Email Window. attachments are added via a toolbar button on the
Send Email dialog.
llH‘l’MLhﬂl-..-ll--n-n

& Font settings

Paragraph, Font,
- Vhlhnﬂndhw M-MM-M.WL’M,-MI&IH‘IL
markup is shown. These modes are accessed via tabs at the botiom of the editor pane

38917 - Support HTML, Merge Field, and Other F in C Email Dialog
Update the existing Compose Email dialog accessed from the Web Access Address Book screen with ITTML (Rich Text)
control, merge field option (feature 36152), and Address Book look-up for To, OC, and Ber fields (feature 36118).
36138 - Support View Menu and View Bar for Email Window
Add the View mens and a filter control to the Email window to allows users 1o filter emails (Al Emails, Today s
Emails, Yosterday's Emails, This Week's Emails, and This Month's Emails)
36105 - Support Move to Folder in Email Screen
Users are able to move to a single email to another folder from the Email screen. The new Edit > Move 1o Folder menu
option displays the “Move Item” dialog that allows the user 1o specify the target folder The selected target folder (after
being clicked) is bolded. This selection is maintained for the life of the session Folders which can't be a target folder
for the current message are shown in ttalictaed hight biue
36118 - Support To, CC, and Bec in the Send Email dialog
When either To, Ce or Bee button s clicked on the Compose New Email dialog, display the Add Email Recipient dualog
box. The desired email recipient (Address Book entry) can be searched by Last Name. or Company
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38546 - Support SMTP and IMAP User IDs and Passwords Flelds

Allow the Maximizer Web Access user to specify their SMTP ar IMAP User ID and Password by adding these fields to
the Email tab under Preferences

33661 - All Sites - Supp h Mode for SQL Server

Support Windows Authentication for SQL Login for all Sites. Note Windows Authentication or Single Sign On is not
supported in Group Edition.

36152 - Support Emall Merge — Maximizer Web Access Compose Emall Dialog

User clicks the Insert Fields button from the Compaose Email dialog for a list of available merge fields. Merge field is
populated when email is sent

32298 - Dialog Load Time Improvements (caching option lists)
Optimization have been made by caching list options for the Address Book, Custom Service, Opportunity, New
Appointment, Column Setup, New Knowledge Base Article, and Search (that include list) dialogs.

26032 - Territory Management (configuration)

Allow Sales Managers to add, modify, and delete setup territory rules and define alignment conditions for Address
Book entries. This feature is related to: 34882, 38253 - Territory available in the Edstion only
34882 - Territory (Search and Conditions)

Support searching for Address Book entries by territory and support territory alignment conditions within the
Maximizer Web Access.

35070 - User Preferences - Personal Settings Only

Support the ability to view and edit personal preferences through the Employee Portal. All existing calendar
preferences including Default calendar view, working hours/days, Calendar access, Hotlist carry forward unfinished
tasks is available to the user In addition, email preferences with relevant email options are also available to the user
34682 - New Calendar View; Weekly List View

The Weekly List view displays appointments and appointment details for one week. All days of the woek are displayed
starting with Monday

34718 - Support Multi-Contact Appointments

The Appointment dialog has been nod-ud to support the new appointment feature, Multi-contact support,
Products/Services and Categories, Acti

34687 - Support Two Level Security on Favorite Lists

A favorite list now supports two levels of security; Full access and Read access. Full access provides the assigned user
(or security group) the ability to modify or delete the favorite list. Read access provides the assigned user (or security
group) the ability to see and use the favorite list.

34691 - Support Two Level Security on Column Setups

A column setup now supports two levels of security; Pull access and Read access. Full access provides the assigned user
(or security group) the ability to modify or delete the column setup. Read access provides the assigned user (or security
group) the ability to view and use the column setup.

34689 - Support Two Level rity on Search Catak

A search catalog now supports two levels of security, Pull access and Read access. Full access provides the assigned
user (or security group) the ability to modify or delete the search catalog. Read access provides the assigned user (or
security group) the ability to view and use the search catalog.

33868 - Allow User to Turn Off the Tabs in the Icon Bar

‘The user can choose 1o turn off the three main tabs (Sales, Marketing and Service) in the lcon Bar Properties dialog
box. Access to the different modules is via a drop-down. Note that individual tabs may be hidden if the user does not
have access rights to those modules. This feature is related to feature 16168.
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33634 - Document Category Field: Maximizer Web Access

The Maximizer Web Access supports the new Documents Category field User Access to this system field is controlled
from ) Web Access Ad

33869 - Ability to Set UDF Folders, Items, and Fields as Active/Inactive

Each user may specify if hidden UDF Folders, UDF fields, and table items are to be shown. An exception to this rule is
that mandatory UDFs cannot be hidden.

36121 - Support Spell Checking in Maximizer Web Access Email

Support spell checking for plain text or HTML messages in the Compose Email dialog.

32274 - Use ASP.NET 2.0 Tree Control

The tree control used in the UDF tab, Links and Company Library screens have been updated to use the tree control
available ASP NET 2.0. This provides a consistent look for all tree controls in the Portal. Additional benefit is delayed
loading until a folder is clicked in UDF and Company Library. This feature is related to feature 32542 - (Portals) Use
ASP NET 2.0 Tree Control - Search All Fields and Column Setup.

35205 -
The following areas have Mbnﬁn&emdhﬂn* views: Loading the
Calendar windows for the first time. switching from one view to another view (except monthly). Calendar > Edit List

dialog Displaying the Edit List dialog box. My Work Day: mhwwﬂw"uﬂl‘m

Hotlist Task dialog box, switching from one user’s Hotlist Task to another user’s Hotlist Task. Hotlist > Assign Dialog:
Loading the Assign User dialog box, selecting a user. Hotlist > Reassign Dialog: Loading the Reassign dialog box.
Alarm Dialog This part does not have an obvious improved, however, there is a bit of an improvement.
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35567 - Ask at Start up Which Address Book List to View

Support the “Choose an Address Book list 1o view in the Address Book window” in the Maximizer Web Access. List
options are View Empty list, View list from last Maximizer session, View Last Search, View Favorite List or View Saved
Search

35065 - Custom Field Labels (including Import GUI)

This feature includes support to I Interface Customizations and Reset Interface Customizations in the Web

:—m—u.- to display string customization in the Portals. This feature is related to 32201
34245

33111 - Login Page; Default Address Book

A new configuration setting named “DefauitAddressBook” has been added to Web config file for the Maximizer Web

Access. This setting specifies the default Address Book for the “Log in to” combo box on the Login page. Note in cases

when the preset Address Book is defined or user has the “Remember me” checkbox set the “DefaultAddressBook™
it A

35123 - Support Set up UDF via Maximizer Web Access

Support Set up User-Defined Fields has been added to the Maximizer Web Access.

36089 - Multi-Contact Appointments - Calendar

Support the display of Multi-Contact Appointments in Calendar; Daily and Weekly list view Include Address Book

entries in tooltsp. email reminder, and when logging notes

32220 - Support Hotlist Task and Appointment Alarms in Maximizer Web Access

Suppart alarm notfication while logged mto the Maximizer Web Access from both Hotlist Tasks and Appotntments

Maximizer™ CRM 10 What's New Feature Guide Maximizer Software
Simply Successful CRM

is required when the Alarm dialog and Calendar Windows are loading at the same time. Appointment Dialog: Loading
the Appointment dialog box while Grouping is enabled, selecting a user in the Users tab.

32574 - in the Portals and Middle Layer
o—umm——mu—-ﬁuu.—ﬁ-‘“m
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4.0 Address Book

35074 - Support Multi-Contact Appointments
The ability 10 schedule a single appointment with multiple contacts (users, Address Book entries) has been added
throughout the product Feature related to 36078, 35078, and 35076,
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35075 - Multi-Contact - related dialogs
Lp‘hk:nmAppommn\t related dialogs to support Multi-Contact Appointment feature. Affected dialogs are:
alarm dialog, dialog, and Peg Board dialog.

17171 - Group Users - Multi-Contact Appointment Dialog

Create a control that displays users by the following groupings: All Users, Departments, Divisions, and Security groups
under the Users tab of the Appointment dialog
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34717 - Sup ducts/Services and Ca Fields in the Opportunity/ Customer Service

unllppolmmmuw

Support Products/Services and Categories fields in the Opportunity/Customer Service Case/Appointment dialog bax.
34546 - Support Two Level Security on Favorite Lists (Update)

A favorite list now supports two levels of security, Full access and Read access. Full access provides the assigned user
(or security group) the ability to modify or delete the favorite list. Read access provides the assigned user (or security
group) the ability to see and use the favorite list

34548 - Support Two Level Security on Column Setups (Update)

A column setup now supports two levels of security, Full access and Read access. Full access provides the assigned user
(or security group) the ability to modify or delete the column setup. Read access provides the assigned user (or security
group) the ability to view and use the columa setup.

34547 - Support Two Level y on Search Catak

A search catalog now supports two levels of security, Pull access and Read access. Full access provides the assigned
user (or security group) the ability to modify or delete the search catalog. Read access provides the assigned user (or
security group) the ability to view and use the search catalog.

38830 - Support SKU/ Refe field in Add/Modify Catalog Item Dialog Box
Provide a field labelled SKU/Reference Number to the Add/Modify Catalog Item Dialog Box. When a catalog item is
added to an OrderDesk order, quote, or item inquiry, the Item code field is populated with the SKU/Reference Number
value

35029 - User Can Create or Connect to a New Address Book

From a Maximizer CRM Workstation, a user can now connect to a shared Address Book or create a new Address Book
from the Maumizer CRM Enterprise without having to open the Administrator module.

35233 - Delete Recurring Appointment

The Delete Recurring Appointment dialog box has been updated to include a new option: Delete occurrences that have
not occurred

36433 - Appointment Details Reports
The Details and Full Details Reports have been updated to support the new Appointment
fields, Products/Services and Categories, multiple Address Book entries, and Activities. These reports are accessed
from the File > Print > Appointment Details menu when the Calendar is the controlling window.
39644 - New Reports
& Sales Quotes - hp-ndbybmhnphumpoﬂdhphy-!-knowuthhnmdmmmn
days, 310 60 days, 61 to 90 days, or 90 plus days ﬂ-uwﬁ--vnl‘k the OrderDesk window.
& Automated Email Campaign Response - This report displays the Automated Email Campaign statistics by
displaying the recipient’s Email Open and Click through activity. This report is available from the Reports >
Crystal Reports > Marketing menu.

& Sales Quote - This report displays a single Sales Quote. This report is similar to the Order Report but
includes Sales Quotes specific fields like Discount and Expires after date. Report is from OrderDesk.

& Opportunity (Won) - Leader - This report is similar to the Opportunity Pipeline report but for won
opportunities. Report is available from the Reports > Crystal Reports > Sales menu.

& Favorite Lists - Mulhﬁmhhhwmmmhmmmm>
Crystal Reports > Administration men:

- Cnlm!ﬂw-ltpu\:umuiu—mhmmu This report is available from the Reports >

Crystal Reports > Administration menu.

35040 - Store vertical packs In SQL
Vertical Packs are now in Microsoft SQL format.
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34560 - Group Users - Multi-Contact Appointment Dialog

Support additional groupings for Teams, MS Exchange Users, and Disabled Users under the User tab of the
Appointment dialog Differentiate between enabled, disabled. and MS Exchange users using icona. Preferences optioas
allow Maximizer user to hide or display these grouping Note the MS Exchange Users tab is only svailable when
MaxSync for Microsoft Exchange has been activated.

35076 - Multi-Contact Appointment - Action Plan dialog

Update Action Plan dialog to support Multi-Contact Appointments.

35077 - Multi-Contact Appointment - Text Field
Np’w‘lumnlhhﬂmdlhAmlnlmex memmmmnmlnhmlmh
all users 1o see. This field with Outlook and MaxSync for Microsoft Exchange
34558 - Products/ Services and Categories fields Added to the Appointment dialog

Support Products/Services and Categories fields have been added to the Appointment dialog box

34588 - New Calendar View; Weekly List View

The Weekly List view displays appointments and appointment details for one week. All days of the week are displayed
starting with Monday. This feature is includes 34682 ~ New Calendar View; Weekly List View.
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33541 - Show Tooltip when Mouse-Over the User Drop-down List
}blonlupﬂnbudbmhudl“-h&cm-uh‘hh-!hm-ﬂnL'-r
rop-down list.
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39529 - Create Help -> Other Products Dialogs for Products
Create Help -> Other Products dialogs for the prod for Black CRM Workfl
Knowled, Web Access, Wireless Access, Maximizer Partner

Access, and Maximizer Customer Access.
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5.0 Sales

32199 - Support Sales Quotes

Support for Sales Quotes has been added to OrderDesk. Sales quotes can be generated for an Address Book entry or
the Address Book entry of an Opportunity. A quote supports status properties like Expires after, Quote date, and
Quote status. The Quote status field has two user values (Active or Inactive) and one system value, “Expired’

Sales Quote items can be manually entered or read from a catalog (features 36345 and 39334) using the Get Item Info
from Catalog option on the Add/Modify Item dialog. Discounts may be applied to a sales quote and a quote can be
converted into an order
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Three sales quote reports have been added: Sales Quote (39644), Expiry Date Approaching (39644, ).ndhpmdhy
Date Range (39635) The Sales Quote report can be used to print-out a single sales quote. Alternatively, Microsoft

Word can be used to print-out a sales quote using sales quote templates (39337) or by using merge fields (39148 and
38076) available from the Maximizer Toolbar in Microsoft Word.

36345 - Support Adding and Editing Catalog Project from the OrderDesk window
(New/Updated)

Support adding and editing catalog projects from the OrderDesk window by adding a menu named Product Catalog to
the edit menu. When this menus is selected display the Product Catalog dialog box and allow the user add or edit
Catalog projects that in turn, can be inserted into an OrderDesk order, item inquiry, or quote via the ‘Get Item Info
from Catalog’ button. This feature includes 40155 - Rename Edit menu item from Catalog and Items to Product
Catalog

39334 - Support UI to Specify Catalog Project Location for OrderDesk

Provide an interface that allows the OrderDesk user to specify the catalog source when adding items to orders, item
inquiries or quotes via the Get [tem Info from Catalog button (feature 36345).
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@uﬂm’y Management Report
This report located under the Reports > Crystal Reports > Sales menu displays all companies and individuals group by
territory. This report is available for Enterprise editions only.

39635 - Sales Quote Expiry Date Approaching Report

This report allows Sales reps and Sales Mangers to report on active sales quotes order by expires after date ascending.
37731 - Update Escona Tutorlal with New Data
ThclumanutomlMdmmL-hnumthlhmmmmwmm has
been updated with new | data. New ] data has mmhmmm
Hotlist Tasks, Sales Quotes, Opponunm& Customer Service Cases, L l data has
been updated for existing features like Action Plan templates, Dashboards, U-cunndmnnnunldn.hnb«n
added for new features like Territory Management and Sales Quotes.

%z:of)u Dashboard forMyworkpbay T A%
B

Dashboard tab to My Work Day screen to allow the display of dashboards.

39148 - Support Creating Sales Quotes Items Table Merge Field

Add "Expires after’, "Quote status’, and ‘Discount Total' merge fields to the Insert Merge Field dialog of the Maximizer
toolbar from Microsoft Word. [n addition, add ‘Item Options (Line separated)’ and ‘Item Options (Comma separated)’
options to the OrderDesk - Item Table Merge Field Setup (feature 38076)

39337 - Defauit Item Table Merge Field & Sales Quote Template Microsoft Word

When an Address Book is created or upgraded to Maximizer CRM 10, ereate two OrderDesk - Item Table Merge Fields
definitions, Advanced Item Table and Simple Item Table. These item table merge fields can then be used from
MmﬁWodlnmlt&klommMmm.mﬂchhoqwuumﬂmmlnﬂlbkfﬂ!‘
the New > tab within ft Word. These lates illustrate the use of the item table
Mefn&u-ﬂlumh«&hmmﬁem

25825 S0
The foll d d interface have been made
- Suppnnmm'mkwhnheuﬂorbun From the dashboards, color for the Color bar selection is available

properties page

- Duphylh'mmnlduhboudﬁhmmlhccﬂmﬂubdthmﬂmmh

& Support target indicator for desired level for gauge. Note not all gauges support target indicator

- A,llmnuﬂmunﬂnltmnpﬁ(mhndx‘uuwﬂum“b&dpmhﬂywdw

P

Support Scroll Bar in Properties Dialog
Horzontal scrollbars have been added to the Available Indi and Current Ind controls on the Properties
dialog box for Dashboards
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On the Other System Options dialog box - which is accessed under File > Preferences - add the following options for
Professional and Enterprise Editions: eStore, Maximizer CRM, and ecBuilder. For Group Edition provide the
Maximizer CRM and ecBuilder options only

38076 - Support C g Sales Qi Items Table Merge Field -
MMM!MW(M&&&R“IMW&H&WMWM%M Defined
item table merge fields can then be merged into a ft Word d using the Toolbar in Word

ThnOnkanl—Imm'hbkMuphcld!«upk-tmu.mhbkﬁmllnlhmu-hnth&\ktm
following window has control

08642 - Territory Management
The new Territory Management feature allows Administrators or Sales Managers to assign Address Book entries to a
territory  An Address Book entry can be manually or automatically assigned using assignment rules and alignment
conditions Users can search Address Book entries by territory, include territory and territory status ficlds in column
setup. This feature is related to features: 26032 - Territory Management (configuration), 34882 - Territory

Search and C 38252 - Territory Management available in the Enterprise Edition

only
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6.0 Marketing

11184 - Show (In and Won) for specific Campaign(s)
Show Opportunity revenue (In Progress and Won) for specific Campaign(s).

32143 - Direct Insert option Added to Web Inquiry Form Wizard

The Web Inquiry Form Wizard now supports the direct insert of Web Form data into an Address Book.

22873 - Add Maximizer Word for Fax
Um“mmmwdmm(mﬂumAMMmu—
ft Fax service. P only
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7.0 Administration

16485 - New User Role; Administrator

A user with the Administrator role can open the Administrator module and perform many of the tasks previously only
possible by the MASTER user

09820 - Modify System Tables

The “Modify system tables” permission controls if the Maximizer user can edit system tables. When "Modify system
tables” option is off, [Edit List ] does not appear in the drop-down lists for system tables

16168 - Allow the User to Turn Off the Tabs In the Icon Bar

Allows the user turns off the tabs in the lcon Bar When tabs are turned off the lcon Bar is expanded, the gray vertical
bar for tabs is hidden. The pin and the current module name will be displayed inside the [con Bar. The user switches to
2 different module by using the drop-down menu

23924 - Correct Ma UDF assigned to Co Case

Additional validation has been added to the Verify Address Book to correct an invalid scenario of Contacts being
assigned to the MaxExchange Distribution field.

34576 - Allow Transfer, Allow Import, and Allow Export

The Allow transfer and import/export access right has been divided into separate entities in the user's or group's
access rights: Allow transfer, Allow import, and Allow export. This allows an Administrative to permit users to import
but not export or allow transfer without import or export or any other combination

35574 - Support and Mobile C: in Users Dialog

After Accounting Link has been installed an Accounting column appears within the Users dialog box. After MaxMobile
has been installed a Mobile column appeary within the Users dialog box. In both cases the column displays either
Enabled or Disabled indicating the user’s access. In addition, the Actounlmg and Mobile options appear in the Module
login for the both the Web Access Ad: and

35039 - Simplify the Create a New Address Book Wizard

Simplify the Create New Address Book wizard to support new SQL database options.

39317 - Supp

The Document Administration feature is available from the Administrator module and supports converting document
over a specified size to a linked document; moving the document from the Address Book to a specified folder.

35092 - Support Products/Services and Categories relationships

The administrator can set Categories to be sub-items of Products/Services.
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36715 - Custom Label - Sites

Support the display of custom labels (32201 - Custom Field Labels) in sites: Partner and Customer Access, Maximizer
Web Access and Web Access A

33713 - Maximizer Web Services

Maximizer Web Service allows third party devel h CRM over HTTP.
ummmvwwmwmm&mmmmwwmwmwpﬁ
32579 - OLE Automation: Additional Searches

Newnanhubf(\mmcrkmt‘um BSunhlndnor““' dify b

hByUDF and Knowledge Base Articles SearchByCreator, mu\umfymhm
b«nldded
33562 - User Object data)
Insert deUuMnmﬂlmml user that can inherit properties from another user.
33563 - View with Static Column Setup

Added a new function named ReadUserView to ColumnSetupAccess object 10 support return of the DataTable object
which contains the list of user
33667 - OLE with New ¢ y Field

Documentation has been updated to support lh- new category field
& AddOLEDocument
& GetDocumentDetailsEx
& UpdateDocument

34705 - New OLE Automation Hook: ApptButtonHook

The ApptButtonHook allows integrators to add a button with a custom label to the Appointment dialog. When this

button is clicked, custom action can be implemented. This feature is related to feature 34709,

34709 - Supp MM

The A k is d in the Portal dialog Button visibility and label caption is controlled

via Web.Config. Button logic is controlled via AppointmentHook js.

35080 - Support Multi-Contact Appointments

Appointment related functions have been added or updated to support

Suite. New functions: AddABEntry, oeunv.nuy (ku\untryl‘v. Mdl.lnr. DclUnr GetUserList lnndthma.hnn

35087 mdudulhchllovnqm
Object function lndunr- function (Notify

35099 - Support Products/Services and Categories

The following functions have been added or updated to support the retrieval of Products/Services and Categories

fields

& SetCustomerServiceFieldValue

& GetListOModifiable UDFTableltems
& GetListOfUDFTableltems

& GetListOfUdfTableltemsDep

The GetListOfUdfTableltemsDep function was added to support the Products/Services <> Categories relationship.
39041 - New Link

The Customization Suite Guide has been updated to include the new and methods d with the new
A Link for ft GP
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8.0 Customization

32201 - Custom Field Labels

Upon the installation of the Customization Suite the Interface C: is installed. This

allows the modification of dialog, window, and menus labels Interfaces customizations are exported and then
imported into the desired Address Book via the Administrator (34245) or Web Access Admunistrator (35065). All users
of an Address Book in which has been customized in this fashion will see the changes. the Customization Suite is only
required for administering the changes.

Note custom labels made with this new feature take precedence over those created with the old Custom Interface
feature

34245 - Support Import of Custom Field Labels

Support the import of custom field labels created by the [nterface Customization program (32201). Add two menus
options under the File > Import menu in the Administrator module: “Imterface Customization” and “Reset all Interface
Castomuzation”. The “Interface Customization™ option is used to import the file of custom field labels desired The
“Reset all Interface Customuzation” option removes all custom field Jabels for the current Address Book
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39790 - C Suite ch for CRM 10

The Cx i dified mnto a ungle type. The C Suite now

dl-o-ub.\'uh-l—lvﬁn-ll

36076 - Document Late Binding Methods and Include Sample Code
The Customization Suite has been updated to include documentation and sample code on Early and Late Binding for
MaAccess Object.
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9.0 Architectural

09809 - Support Windows Authentication Mode for SQL Server

When & Maximiser User b configured 1o use Windows Authentication, they Ily logged into

and the SQL Server; SOL Server set to Security Mode of “Windows Authentication mode” (SQL Server 2008) or
Windows only” (3QL Server 2000) Note, 38260 & 38300 - Windows Authentication and Single Sign On is not
supported by Maximizer CRM Group Edition

35043 - Installation to Embed MS SQL Server Express

Where previously the Pervasive SQL database engine would have been installed now install Microsoft SQL Server
Express

38243 - Create Installation for Three Editions of the Maximizer CRM

Support three product editions. Maximizer CRM Group Edition, Maximizer CRM Professional Edition and Maximizer
CRM Enterprise Edition The installation determines which edition 1o install based on the PEN specified during
installation This feature includes 38240, 382 - Reporter Mndul- Amhbb in Maximizer CRM Pmﬁ-nul and
Enterprise Edition Only; 38236, 38259 - K e Base Module bl C Edion
Only, 38253, 38257 - Territory Management available in the Enterprise mnnm Only; 38254 - Pax/Print Campaigns
Available in Enterprise Edition Only, 38251 - Update Installation Wizards with New Product Name. This feature is
related to feature 39450 - Group Edition does not support SQL Analyties or Reporting Services

23578 - Database/ User Creation Creates Default Records of all Types
This functionality is beneficial for a number of reasons
® MaxExchange no longer has 1o check if Default Entry records have been created at different locations st the
same time
& Administrators can easily edit any User's Default Entry record with the “Edit All Default Entries”™ menu
seloction. Currently an admin needs to foree the creation of the record(s) first

38616 - Perform Address Book Size Check at Start-up (SQL Server Express Only)

When Maximizer CRM is started, perform a check to determine if the Address Book is reaching the size limitation
imposed by the underlying database server In cases where the Address Book size is approaching the sise limit, display
a message with information on how the Address Book size may be reduced or upgraded. This feature is related 10
38617 - Perform Address Book Size Check at Start-up (Maximizer Web Access)

38988 - Support Option to the SQL Exp ddress Book Size Check on Login
Add a "Don’t ask me again® checkbox 10 the Address Book Size Check dialog to allow the Address Book size check
procedure 10 be disabled. Add the “Check Address Book size at login™ check box 10 the System Defaults tab ander
Preferences to allow the Address Book size check 10 be turned back on. This feature is related to « Support
Option to Disable the SQL Express Address Book Size Check on (Maximizer Web Access). For Web Access, the
“Check Address Book size at login® option is located under Preferences dialog (Options -> Personalize)

38612 - Support Upgrade Address Book - Convert Documents Utility

Thuuhlnyunb- undhy-dmmnnafnumnm-qm',wosm-lmhhhn nwﬁq(n
CRM 10 by bedded documents 1o linked d

10 Group Edition for which the un&dm SQL Server Express database server mp-d size limitation

38615 - Maximizer CRM DB Sizing Estimation

This standalone utility is used prior to upgrading » Pervum dnuhn 10 estimate the size of the database when

converted to a SQL Server database. This is ding 1o CRM Group Edition

as the workgroup engine (SQL Server hpu--)huuocld-ubm lm

37107 - Install \NET Framework 3.0

Support installation of NET Framework 3.0
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10.0 Productivity Improvements

32367 - Add Column Setup Support to the Hotlist Window
Support column setup in the Hotlist window

38604 - Add New Basic Fields to the Hotlist Column Setups

The following Address Book related fields have been added 10 the Basic Fields tree of the list of available fields for a
Hotlist column setup: Full Access, Read Access, Address Line 1, Address Line 2, City, State/Prov., Country, Zip/Postal,
and Account Manager The Full Access and Read Access represent the rights of the Address Book entry that is
associated with the task or 1f the task or hbnunov-oppnum, lh—l\nmh-nl
dusplay the access rights of the Address Book entry that is d with the case/oppx

multi-contact appointment, these two columns are blank The following task/appointment ulu-d fields have also b.-
added: Creation Date and Creator

34554 - Add Support for a Global Remove from Within the Global Edit Dialogs

Support the global remove of User-Defined Fields values via the global edit dialogs for Campaign Manager, Customer
Service, Opportunities, and Address Book modules.

26154 - Document Category Field

When adding/inserting a document into the Documents window, the user can specify a category. Documents can then
be searched by category The Administrator creates the list of category values for this system field. Note that this
feature does not include any GUI changes for the Company Library module.

25482 - All Methods of Emall Follow for Saving of Note or to Documents
All methods of Send / Write / Reply / Reply All / Forward to Email always follow the Save Note or 1o Documents
defaults set by the Email Preferences.

16177 - Search for No Value (Desktop only)

Provide the ability 10 search basic fields and User-Defined Fields for no value. Add the ‘Search for no Value’ check box
10 the dialogs for lp("y\:r value(s) to search for. When Search for no Value is selected, search returns records where
no value has been assigned. This is supported for Address Book, Customer Service, Opportunity, and Campaign
Window

34160 - Move Redundant Text at the Beginning of History Email Note

The format of a history email note has been changed. The text “An email has been sent to ‘Address Book entry <email
address>’_ " has been moved 1o the end of the history note after a separator and carriage return.

37425 - Auto-Sig! C Limit to 5000 Characters

The Auto-Signature field now supports up to 5000 characters.

25742 - i Checkl pport for All Email Addresses and All Phone Numbers
The “All Email Addresses” And'AIlthuan options have been added to the list of fields to match,

11250 ~ Support Show Hidden for UDF Folders and UDF Flelds

Add the “Show hidden field” check box 1o the User-Defined Field (UDF) window, to the Select Field for Search dialog
box, and the Select Table Field Valuos for Search dialog box to allow users to show hidden UDF fields. The *Set to
hidden” attribute is used to denote that UDF is hidden. This feature is related 10 09367 - Support Show Hidden for
User-Defined Fields (Database)

Note a UDF is always displayed when the field is currently selected or when it is mandatory
32288 - HTML Spelichecker
11TML spell checking has been added 1o the Compose Email dialog box
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35034 - Changing Password - Group Edition Only

When a user changes any user’s password and there are multiple Maximizer Address Books on the server hasting the
Address Boak, the password will be changed for that user in all of the Address Books

38249 - Update Labels, C and to CRM .
umdummummlnhm‘dhumm This feature is related 10 38250
Update Labels, captions and graphics to Maximizer CRM (Thin)

39264 - Change Product Name from CRM to

On PPC and Smartphone device, the product name is changed from MaxMobile CRM to MaxMobile The three mobile

This feature includes 39265 - Change Product Name from bile CRM to MaxMobile (Black! 38892
Change CRM to e ( !

39306 - Change Product Name for Portals

The follering product name changes have boen made in the application and documentation
6 Employee Portal has been changed 1o Maximuser Web Access
6 Partner Portal has been changed 10 Partoer Access

® Customer Portal has been changed 10 Customer Access
® Wireless Portal has been changed o Wireless Access

When collectively referring to these products the term ‘sites’ This feature includes feature 39328 - Change Product
Names for Portals in Maximizer CRM

39566 - Update Properties Dialog Box Labels

v the following labels in the Properties dialog box In the module section change Maximizer to Windows
".M'Mduwdu-luw.n&:uhm In addstion update
corresponding label on the Users dialog box and the Install Multi-user License dialog box

39405 - Maximizer Web Access to Respect Trial
mwﬂmmm-—b’mmmﬂmdwmnuwm“
trial then display a trial status page with a Continue bution, the Continue button is not available if the trial has expired
37574 - Update Report Logo

Update the "Maximizer Enterprise” logo on exiating reports with “Maximizser CRM™ This applies to reports accessed
by the Reporter module. Dashboards. and reports located under the Reports > Crystal Reports menu.

38598 - Update the Other Products Lists

Update the Other Products lists for each Maximizer CRM edition, Group, dard, Profe and This
feature includes feature 39529 - Create Help - >ml-ml-h'bfll“m

38597 - Update the More Information URL

Update the More Information URL for each product listed ander Help > Other Products.
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37072 - Display User’s Icon in the Daily Calendar Report

Support displaying the user’s icon in the Daily Calendar report. Also, prompt user if they would like to include calendar

legend with the report. Note that the time interval printed in the report is always 30 minutes, regardiess of the value

that the user has selected in Preferences.

32292 - Reduce Start up Time

Optimizations have been made to reduce the start up time for Maximizer CRM

19120 - MTI Import Optimization
Transfer Interface (MT1)

have been made that reduces the time 1o import MT1 files that have

Note text.

32835 - Sort Order for Different Languages

To support the correct sorting of non-| character sets within Maximizer, a file named CustomSortTable txt may

be created with the desired sort order mdnhmn-mhln Upon start, Maximizer reads this

file and sorts information accordingly. Two example customer sort order files are installed with Maximizer,

CustomerSortTable _Russian. txt and CustomSortTable_Ukrainian txt.

32938 - Convert the F1 WinHelp files to HTML

The Help files for CRM and have been converted to IITML.

34905 - Define Character Set for Emall Service

The administrator user can set the default character set 10 be used by the email service (Automated Campaigns and

Email Notifications).

40153 - Provide Expert Advice from Maximizer

w-mum-mmuu--um-dumw ‘When either the button or

menu is selected open a browser window and display Expert Advice from CanDoGo'

35570 - Icon Bar Elements Visibility

Icon bar elements will be visible or hidden based on the user's security setting. Sales tab will be hidden when user does

not have read mumﬂ:wumn——hmmumum
Knowledge Base

Service tab will be hidden when user does read rights to Customer Service and
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11.0 Integration

36339 - Accounting Link for Microsoft Dynamics GP

The new Accounting Link for Microsoft Dynamics GP supports Microsoft Dynamics GP 9 0. This feature is includes
featares 36337 - Create Following Window - Support linking of Address Book Entries and Dynamics GP Accounts,
36304 - View/Update Transaction, 36338 - View Dynamics GP Customer [nformation; 36299 ~ Support Dynamics GP
Invoice; 36300 - Add New [tem. 36301 - Support Dynamies GP Quote, 36302 - Support Dynamies GP Purchase Order;
36334 - Shortcut menus for Accounting Window; 36305 - Create [nvoice from Selected, 36303 - Create New Dynamies
GP Transaction from Selected, 363373 - Create Microsoft Dynamics GP Customer/Vendor, 36335 - Control Windows
Menu Commands (Edn), 36336 - Recording the Transaction as a Maximizer Note, 36340 - Configuration - Security &
Licensing, 37728 - Configuration - Accounting Setup, 36332 - Product Name and Labeling

33882 - Support for Microsoft SQL Server Reporting Services (SSRS)

Support for Microsoft SQL Server Reporting Services has been added An option has been added to the System Options
tab of the pref dialog to allow Ad 10 specify & valid Reporting Services URL. When a valid SQL
Server Reporting Services location is specified a new menu named “SQL Server Reporting Services™ appears under the
Reports menu. Like the Crystal Reports menu, the SQL Server Reporting Services menu will be dynamically generated
based on the reports and folders available on the specified SRSS The menu also includes a “Refresh” option at the
bottom, which refreshes the menu. Note: there is no “Personal” folder as this feature supports server side reporting
only

37930 - Install SQL Server Reporting Services samph lm

Add an option 1o the Maximizer CRM Server installer (Prof d to include ft SQL
Server Reporting Services sample reports. When selected, the SSRS rrpm are copied to the SvrShare\ Reports\SSRS
Samples folder The samples reports must be deployed manually to SQL Server Reporting Services.

34414 - ] - Record Creation Confirmation Dialogs

When saving & contact (Save Contact to Maximizer) or email (Save Sender as Contact to Maximizer) from Outlook to
Maximizer prompt the user for information on how 1o create the Address Book entry in Maximizer Confirmation
options are Company, Individual, or Contact for an existing Company/Individual. In the case of Contact for an existing
Company/Individual, user is provided option to search for desired Address Book entry.

33928 - Maximizer CRM Gadgets

Two gadgets have been created  Address Book Gadget, Sales Dashboard Gadget

Sales Dashboard Gadget and Address Book Gadget require Maximizer CRM on Windows Vista Operating System
35140 - n.wmuapuumnoa/mmm

Support new phone mapping hm when £ between for and Outlook (MOCI) and
Maximizer and Microsoft Exchange Server (MECT)

35082 - Multi-Contact Appointments - MaxAlarm

MaxAlarm has been updated to support Multi-Contact Appointments.

35089 - d to Support Multi-Contact Appointments

Outlook Synd\mmuhon has been updated to support the new fields for the multi-contact appointment.

33817 - pp Mode for SQL Server

Support Windows Authentication mode. Users should not have to supply login info if mapped to a Windows domain
user. Note Windows Authentication or Single Sign On is not suj in Group Edition
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10933 - Support Double-clicking on the Shortcut to Open the Ma: Server gt

When the MaxExchange Server Manager is running and its icon is minimized in the system tray, restore the
MaxExchange Server Manager when the user double clicks on the desktop shorteut

16069 - Add to C Server

If the Server transportation method (FTP, Email, and Network Direct) is not set and a user launches Server Manager,
pop up a message box informing the user that they need to configure their server settings. Implement for
Server/Remote Server

36171 - des Write New Book to Shared Folder

During a Pervasive database upgrade a file will be created in the database folder with information about new Address
Book location. File name is DbTrackinfo.txt

35177 - ctions for Setup y Groups and Teams

Support transaction created by the setup of security groups and teams from the Web Access Ad:

This feature is related to 33160 - Setup Security Groups and Teams.

39597 - Support Products/Services and Category Transactions
This feature ensures transactions are created for Products/Services and Category changes via Administrator and that
those changes are synchronized.

12.2 MaxExchange Remote

34874 - to Send Packet to h Server when there are no
Changes
When a Remote with the h Server, if the remote has no change an ac)

packet will
created by the remote. This behavior is advantageous as it allows the backup files for the site to be cleared and avoids
messages claiming that the site has not processed.
36040 - Support Create New Address Book Option on Initial Refresh

When the MaxExchange Remote receives the initial refresh, prompt the user to select an existing Address Book or to
create 3 new Address Book. If the user chooses to create a new Address Book, the Address Book is created locally.

17346 - Packet on Subject Line for Email Transport
wmnwmnwbrmlumhdmuhunm&mwmum
33825 - Sup| Part to Line of Email Packet for Split Packets

When a MaxExchange packet is split, include the part number (along with the Packet Number - 17346) in the email
subject line.
35042 - Change MaxExchange REM File from Pervasive Format

The first time MaxExchange remote is launched after Address Book upgrade MXZREM MAX (Pervasive) is converted
10 MXZREM BIN file. This feature is related to 36171
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12.0 MaxExchange Synchronization

12.1 MaxExchange Synchronization Server

32314 - Sy of with Same SPDM/Site Manager
h supports sy of multiple b with same SPDM/Site Manager
33660 - Mode for SQL Server

h"nnw-bnA-ununlmlmSQUm Note Windows Authentication or Single Sign On is not supported in

Group Edimon

36974 - Support Multi-Contact for All Add: Book Entries at Remote

Support Multi-Contact app , all malti records should h 10 remotes when one

or mare of the related Address Book entries exists at the remote Any attendees that are not synchronued to the

remote should be denoted by ‘N/A' in the appointment dislog at that site

35050 - Supp: y of New Fields

Support of the new fields, Address Book entries, Activities fields. This

feature includes 15049 - Support Synchronazation dAppnuw-m- Products/Services and Categories Fields.

33635 - Support the Sy of the New Document Category Field

Support the of the new d ulrmf-hl(zs:sq Document Category Field). This feature is

related to festure 35181 (Create a Category Fi which supports the synchronization of

Document Category Field transactions for MaxMobile

37481 - Support Synchronization of Custom Fields

Support synchronization of Custom Fields feature (32201) Support Add. modify, and delete transactions

38310 - Supp C to and Server

The ibute [ nterface C: 10 Remote and Remote Server option has been added to the MaxExchange

Site Manager Server Settings screen mmmMmWWMMhmmﬂdcmiﬂd

Labels (32201) are 10 be Remote and Remote Workstation(s)

16181 - Add "Address Book Verification” to Server r's File Menu

The Address Book Verification feature has been added to MaxExchange Server Manager File menu.

35822 - MaxExchange data Encryption

Implement encryption for SQL based MaxExchange data packets.

37973 - Ma to Product Catalog Transactions

Support the synchronization of Maximuser Product Catalog. This feature i related to 36345 - Support Adding and

Editing Catalog Project from the OrderDesk window.

38978 - S‘nvt

Op for h h Remote have been made. Packet processing duration has

M-Mﬂhmmmm by passing the step of writing the data to a table and then

exporting Memory usage has been optimuzed by freeing allocated memory as soon as s purpose as been

accomplished

35061 - Support Transactions Created by Global Remove from Within the Global Edit Dialogs
supports created while perform a global remove. This featare is related to feature 34554

16747 - Press Refresh Button for Site Clears Outbox for that Site

Support clearing all OUTBOX folders on Refresh when Site Manager on same machine as MaxExchange Server
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13.0 Appendix — Full Feature List

Note Features not described in this document but included in the product are indicated with an *

Address Book

17171 - Group Users - Multi-Contact Appointment Dialog

33541 - Show Tooltip when Mouse-Over the User Drop-down List
34546 - Support Two Level Security on Favorite Lists

34547 - Support Two Level Security on Search Catalogs

34717 - Support Pndum/m Categories Fields to the Opportunity /Customer Service Case/ Appointment
dialogs
35029 - User Can Create or Connect to a New Address Book

SQL

tment Details Reports
wsm/mmu-mulycuqt—mu
39317 - Support Document Administration

39529 - Create Help -> Other Products Dialogs for Products

39644 - New Reports

09820 - Modify System Tables
16168 - Allow the User to Turn Off the Tabs in the Icon Bar
Administrator

lulu N-\-Uurlnlt

Correct h UDF assigned to Contacts Case Scenario
us‘o Group Users - Multi-Contact Appointment
34576 - Allow Transfer, Allow l-m—dAno-l.lpnn
35039 - &npliyth&mnhn&-look

35092 - Support Prod and G

35574 - and Mobile Columns in Users Dialog
38249 - U, Labels, Captions and Graphics to Maximizer CRM
38250 - Update Labels, captions and graphics to Maximizer CRM (Thin)

23578 - Database/User creation creates default records of all types
35034 - Password - Group Edition Only
35043 - 1 tion to Embed MS SQL Server Express

3n07 - Install NET Framework 3.0
37574 - Update Report Logo
Reporter Module

38235 - lable in CRM Profe \ Edition Only (Desktop)

38236 - L ilable in CRM Edition Only (Desktop)

38259 - dedy Module Available in CRM Edition Only (Thin)

38240 - Reporter Module Available in e | Edstion Only (Thin)

38243 - Create Installation for Three Editions of the Maximizer CRM

38251 - Update [nstallation Wizards with New Product Name

38254 - Fax/Print Campaigns Available in

38260 - uwnmumwwuummuh-(m)
38300 - Windows Authentication and Single Sign On is not supported by Maximizer CRM Group Edition (Thin)
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38597 - Update the Mare Information URL

38598 - Update the Other Products Lists

38612 - Support Upgrade Address Book - Convert Documents Utility

38615 CRM DB Sizing

38616 - Perform Address Book Size Check at Start-up (SQL Server Only)
38617 - Perform Address Book Size Check st Start-up (Maximiser Web Accons)

38892 - Change bile CRM 1o Mobile (

38988 - Support Option o Disable the SQL Express Address Book Size Check on Login
38989 - Support Option to Disable the SQL Ex; Address Book Size Check on Login (Maximizer Web Access)
39264 - Change Product Name from MasM: CRM to MaxMobile

39265 - Change Product Name from bile CRM 1o le () ]

39328 - Change Product Names for Portals in Maximiser CRM

319408 - Maximizser Web Acresa to Respect Trial

19450 - Group Edition does not support SQL Analytics or Reporting Services
39529 - Create lelp > Other Products dialogs for Missing Products

39566 - Update Properties Dialog Box Labels

Custom lzation

32201 - Custom Field Labels

32579 - OLE Automation Additional Searches

31562 - User Object Enhancements (Maximizer data)

33563 - ReadUserView Implementation with Static Column Setup

33667 - OLE Automation Document Punctions Updated with New Category Field
34245 - Support Import of Castom Field Labels

34705 - New OLE Hook

33713 « Maximizer Web Services

34709 - Support New Appt Buttonllook

39790 - O Suite it changes for CRM 10

Integration
33817 - Outlook Integration - Support Windows Authentication Mode for SQL Server
33882 - Support for Microsoft SQL Server Reporting Services (SSRS)

. Accounting
36335 - Control Windows Menu Commands (Edit)

6336 - the T) asa Note
36337 - Create Following Window - Support linking of Address Book Entries and Dynamics GP Accounts
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36321 - Wireless Sync - Sync Address Book entries
36322 - Wireless Sync - Sync

Compression
- Support View Only During Scheduled Wircless Synchronization

36323 - Wireless Sync - Sync Customer Service Cases

36324 - Wireless Sync - Sync Hotlist Tasks

36325 - Wireless Sync - Sync Appointments

36326 - Wireless Sync - Sync UDFs

36556 - Support Activities in Address Book Entry, Opportunity, and Customer Service Case Dialogs
36836 - Wireless Sync Handle Dropped Connection

36837 - Scheduled Sync for bile based Schedule Set on Device
37867 - Support Carrier Specific P for Wireless

39265 - Change Prodact Name from bile CRM to e (Black
39297 - Support Web Service

39626

PDAs

33883 - Wireless Sync for MaxMobile - Wireless Synchronization

Productivity Improvements
09367 - Support Show IHidden for User-Defined Fields (Database)
11250 - Support Show Hidden for UDF Folders and UDF Fields

« MT1 Import Optimization
- All Methods of Sending Email Follow Preferences for Saving of Note or to Documents
- Duplicate Checking for All Email Addresses and All Phone Numbers

- Add Column Setup Support for Hotlist Window
- (Portals) Use ASP NET 2.0 Tree Coatrol - Search All Fields and Columa Setup®
- Sort Order for Different Languages
32938 - Convert the F1 WinHelp files to IITML
34160 - Move Redundant Text at the Beginning of History Email Note
34554 - Add for a Global Remove from Within the Global Edit Dialogs
34905 - Define Set for Email Service
35570 - lcon Bar Elements Visibility
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36338 - View Dynamics GP Customer [nformation *
36339 g Link for h
36340 - Configuration - Security & Licensing
37728 - Configuration -
37930 - Inatall SQL Server Services .
39148 - Support Creating Sales Quotes ltems Table Merge

Marketing

11184 - Show Opportunity revenue (In Progress and Won) for specific Campaign(s)
22873 - Add Maximizer Word Process Support for Microsoft Pax

32143 - Direct Insert option Added to Web Inquiry Form Wizard

&

on the Shortcut to Open the MaxExchange Server Manager

- Add Message 1o Configure Server Settings

16181 - Add “Address Book Verification” to Max Exchange Server Manager's File Menu

16747 - Press Refresh Button for Site Clears Outbox for that Site

- Support Packet Number on Subject Line for Email Transport

g - N of Multiple b with Same SPDM /Site Manager

33660 -Support Windows Authentication Mode for Server

« Support Part Number to Subject Line of Packet for Split Packets

0 Send Packet to MaxExchange Server Even if there is no Change

MazExchange REM File from Pervasive Format

Synchronuzation of Appomtment s Products/Services and Categonies Frelds
ch of New

Transactions Created by Global Remove from Within the Global Edit Dalogs
for Setup Security Groups and Teams
Category Field b
Create New Address Book Option on Initial Refresh
- Upgrades Write New Address Book Information to Shared Folder
36974 - Appomtments for All Address Book Entries &t Remote
37481 - Support Synchronization of Custom Fields
- o Support Product Catalog Transactions
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37072

38604
40153

Display User's lcon in the Daily Calendar Report
Increase Lamit to

Add New Basic Fieids to the Hotiet Columa Setups
Provide Expert Advice from Maxumizer
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36138 - S L Window
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] “ 10t ducts/Services [tems
L Man. e y
18546 SMTY passwords Prelds
» A Ainistra Pred t IMAP and SMTP servens
wort 1ITM ge ! and Other Feat ) Existing Compose Email Dialog
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Wircless Access
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Weekly Calenda
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